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Liam Sloan, Chief Executive

Welcome
For over 100 years NMIT has been providing high quality education  
for students just like you. NMIT is enormously proud of its strong 
international relationships and we have worked particularly hard to 
attract learners from a wide range of countries across Asia, Europe, 
Africa and the Americas.
Our international learners help make NMIT a culturally diverse and 
exciting place to study. Our campuses are vibrant, engaging and offer 
a great place to learn, study and develop the skills that will help you 
become both world and work ready. 
As part of NMIT you will be strongly supported to ensure that your  
time in New Zealand is enjoyable, rewarding and sets you up for a  
great career.
I know you’ll find your future right here at NMIT.

As an international student at Nelson Marlborough Institute of 
Technology (NMIT) you’ll enjoy a world class education in one 
of the most beautiful and dynamic regions of New Zealand. 
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New Zealand

> Population of 4.7 million
> Official languages: English (96%), Māori (4%) and New Zealand Sign Language (0.5%)
> Currency is the New Zealand Dollar
> New Zealand is the second safest country in the world (Global Peace Index, 2019) 
> New Zealand is ranked number one in the world for Social Capital, and in the top five 

countries in the world for Business Environment, Governance, Personal Freedom and 
Natural Environment (Legatum Prosperity Index, 2018)

> New Zealand is ranked first in the world for preparing students for the future (The 
Economist Intelligence Unit, 2017).

New Zealand quick facts

Our campuses
We have three main campuses in the 
Top of the South Island of New Zealand.

Nelson
Located in Nelson’s 
vibrant city centre, 
taking up an entire 
city block, our Nelson 
campus is our first, 
and largest campus.

Marlborough and Woodbourne
The friendly Marlborough campus is located 
on the edge of the town of Blenheim, in the 
heart of New Zealand’s wine country. 

Our Aviation programmes are based just a 
short drive from Blenheim, on the Royal New 
Zealand Air Force Base.

Auckland Flight time 
to Nelson 
90 minutes, 
flight time to 
Marlborough  
90 minutes 

Wellington Flight time 
to Nelson 
40 minutes, 
flight time to 
Marlborough  
30 minutes

Christchurch Flight time 
to Nelson 
50 minutes, 
flight time to 
Marlborough  
60 minutes

International Airports 
and flight times to 
Nelson and Blenheim:



NMIT - A world 
class choice
1
Government 
owned
> Government funded 

institute
> All qualifications 

approved by the New 
Zealand Qualifications 
Authority (NZQA)

> One of New Zealand's 
oldest institutes, 
established in 1905.

3
Reputable 
qualifications
> Internationally 

recognised 
qualifications

> Highest course 
completion rate 
for any Institute 
of Technology or 
Polytechnic in New 
Zealand for 2018.

5
Study to work 
pathways
> Work part-time whilst 

studying*
> Internship opportunities 

available
> Qualifications are 

developed and 
delivered in partnership 
with local industries.

*Where visa conditions allow

Quality
ISO 9001

Registered

2
The highest 
NZQA ranking
> NMIT has Category 

1 status, the highest 
possible, from the  
New Zealand 
Qualifications Authority

> ISO 9001 registered.

4
Student 
approval 
rates
> 94%* of students 

were positive about 
their programme, 
teaching, learning 
and overall first 
impression of NMIT.

*First Impression Survey 2019

6
Award-winning 
facilities and 
technologies
> Award winning Creative 

Industries building
> State of the art 

facilities, including a 
brand new $1 million 
Kongsberg maritime 
bridge simulation 
system and a dedicated 
Computer Generated 
Imagery (CGI) lab

> Ongoing investment 
in modern teaching 
facilities.
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Nelson campus

Purpose built and award winning, Creative Industries building.

State of the art salmon-rearing facility on campus, and close links 
with the world-renowned Cawthron Institute.

Our Library Learning Centre and Student Centre provide 
great spaces for students to study and come together.

The International Maritime Institute of New Zealand, part of 
NMIT, has world class facilities including Kongsberg Marine 
Engineering and Navigation simulators.

Nelson > Located at the geographical ‘Centre of 
New Zealand’

> Regional economy includes food production 
(seafood, horticulture and viticulture), 
science, transport and construction, 
aviation, engineering, maritime, tourism, arts 
and design, information technology, retail 
and services

> Three national parks nearby; Abel Tasman, 
Kahurangi and Nelson Lakes

> Cultural events throughout the year. 
Including arts, music and film festivals, craft 
beer festival (March) and local sports 
throughout the year

> Highest sunshine hours in New Zealand 
(NIWA Annual Climate Summary, June 2019).



I had such great 
lecturers at 
NMIT, they were 
teachers as well 
as friends which inspired 
me to study hard and 
helped me to build a good 
work ethic.” 
Jorgen Sovre, Norway, Bachelor of 
Information Technology (Study Abroad)

Nelson's location really supports 
my study as it is located close 
to many aquaculture facilities 
such as fish farms, hatcheries, 
and aquatic research labs. The people in 
Nelson are so nice and welcoming. This 
is a perfect opportunity for me to learn 
more about my education and my life.” 
Giovanno Adnyana, Indonesia,  
Diploma in Aquaculture
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Marlborough campus

Woodbourne campus

On-site vineyard from which our students can make their own wine.

Aviation students study in our purpose built facilities, on the Royal New Zealand 
Air Force Base in Woodbourne.

The Sensory Room and Laboratory are first class facilities 
for wine tasting and chemical analyses, used by local 
industry and students alike.

Marlborough

> The heart of New Zealand’s wine 
country and a world famous wine 
growing region for Sauvignon blanc

> Easy access to the picturesque 
waterways of the Marlborough 
Sounds, and ferry access to Wellington

> Population of 45,000, mostly in the 
township of Blenheim.



The tutors were really 
approachable, friendly and 
helpful." Padam is excited about 
his new role (in aircraft engineering) and 
says he would definitely recommend the 
NMIT course to “cousins and friends” back 
home. “This is the job I always wanted and 
I am happy with it. I also love the working 
environment here and my workmates.” 
Padam Prashad Adhikari, Nepal, Certificate in 
Aeronautical Maintenance Engineering. Aircraft Fitter - 
Adhikari Pacific

The NMIT campus is located 
in New Zealand’s main wine 
growing region. The second year 
internship during vintage allowed me 
to make my own wine, while getting 
course credit, great experience for future 
work and paid quite well. I also got to 
see the different jobs in viticulture and 
winemaking so I could choose the area of 
the industry I would like to work in future.” 
Nichkan Sayasith, Thailand,  
Bachelor of Viticulture and Winemaking
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*Please refer to page 32 for our fees disclosure statement. **Admission to this programme is dependent on a full assessment on application. 

Master's Degree and 
Postgraduate Diplomas

Postgraduate Studies in  
Applied Management
> Entry with any Bachelors degree** 
> IELTS 6.5 (each band 6.0 or 

higher) or equivalent
> Nelson campus
> Starts Feb, May, July, Sep and Nov

Master of Applied 
Management

Level 9
Full time 15 months
Fees* NZ$28,450 for full 15 month programme

Level 8
Full time 9-10 months
Fees* NZ$20,900 for full 9-10 month programme

Level 8
Full time 5-6 months
Fees* NZ$10,450

Entry: Any Bachelor Degree and  
IELTS 6.5 (each band 6.0 or higher) or equivalent** 

Postgraduate 
Certificate in Applied 

Management

Postgraduate 
Diploma in Applied 

Management

Gain 60 credits in the following  
four courses:
> Critical Issues in Management
> Design Thinking & Innovative 

Entrepreneurship
> Managing in a Digital world
> Leadership & managing talent

Gain 60 credits in the following  
four courses:
> Critical Issues in Management
> Design Thinking & Innovative 

Entrepreneurship
> Managing in a Digital world
> Leadership & managing talent

Gain 60 credits in the following  
four courses:
> Critical Issues in Management
> Design Thinking & Innovative 

Entrepreneurship
> Managing in a Digital world
> Leadership & managing talent

Select 60 credits from a range of 
approved industry management 
topics, such as:
> Finance
> International Business
> Logistics & Supply Chain
> Leadership
> Education change Management
> Aquaculture
For a comprehensive list of electives 
see, nmit.ac.nz/MAM

Select 60 credits from a range  
of approved industry management 
topics, such as:
> Finance
> International Business
> Logistics & Supply Chain
> Leadership
> Education change Management
> Aquaculture
For a comprehensive list of electives
see, nmit.ac.nz/MAM

Complete with either: 
> Research Methods, Proposal and 

Project (class taught option) OR
> Research Thesis 

Research project targeted 
to your area of interest.  
For example:
> Health management
> Engineering management
> Human resource management
> Tourism and events management



RNZAF Base
Woodbourne

Marlborough 
Campus

Nelson 
Campus

Postgraduate Diploma in IT 
Security Management

Postgraduate Diploma in 
Sustainable Aquaculture 

Level 8
Campus 
Starts Feb, Jul

Full time 9-10 months
Fees* NZ$20,900
IELTS 6.5

Level 8
Campus 
Starts Feb

Full time 1 year
Fees per year* NZ$20,900
IELTS 6.5

Academic entry: Related IT  
or Computer Science Degree
Course content guide
> Research Methods in 

Information Technology and IT 
Management

> Ethical Hacking and Incident 
Handling

> Governance and 
Development of IT Security 
Programme and Policies

> Legal Aspects of IT Security, 
Privacy and Investigations

> Auditing of IT Assets
> Vulnerability Assessment and 

Risk Analysis
> IT Project Management
> Information Systems 

Development, Implementation 
and Support

Career outcomes: Technical 
director for information security, 
security analyst, security 
administrator, information systems 
security manager, information 
systems security officer.

Academic entry: Science Degree 
This programme will give you the 
practical skills to build on your 
science degree knowledge. You 
will meet many people in industry 
and be able to take the skills 
you learn to work in aquaculture, 
here in our region and around 
the world.
Course content guide
> Research Methods
> Sustainable Aquaculture 

Practices

> Sustainable Aquaculture 
Management

Refer to website for more 
information. 
This programme consists of six 
months in class and a six-month 
industry research project.
Career outcomes: Aquaculture 
production management, 
research technician, specialist 
roles such as health management 
or feed management.

Postgraduate Diploma in Logisitics 
and Supply Chain Management

Level 8
Campus 
Starts Feb, May, Jul, Sep, Nov

Full time 9-10 months
Fees per year* NZ$20,900
IELTS 6.5

Academic entry: Business Degree
Course content guide
> Applied Research Methods
> International Strategic 

Management
> Global Logistics and Supply 

Chain Management
> International Financial 

Management
> Storage and Warehouse 

Techniques

> Transportation, Distribution 
and Network Management

> Strategic Procurement and 
Inventory Management

> Performance Measurement 
and Process Outsourcing

Career outcomes: Planner and 
analyst, buyer, inventory specialist, 
materials planner, transportation 
coordinator, production 
coordinator.

Business

Information Technology

Aquaculture

The approach to study at NMIT is way more practical than what I have seen in the past, 
you notice in the courses that there is a real link to industry. Most tutors have an industry 
background rather than just academic experience.” 
Peter Daebel, Master of Applied Management 

NMIT has partnered with ATMC to deliver two 
postgraduate diplomas in Auckland:

> Postgraduate Diploma in International Business
> Postgraduate Diploma in Information 

Technology Security Management.
Please see atmc.ac.nz for more details.

Study in Auckland!
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*Please refer to page 32 for our fees disclosure statement.  
+Depending on start date, may include Summer School semester. If your undergraduate degree is not in a relevant field, you may need to completed additional courses, which may require 18 months total study.

Graduate Diplomas

Graduate Diploma in Management

Graduate Diploma in  
Information Technology

Graduate Diploma in Marketing

Graduate Diploma in Accounting

Graduate Diploma in 
Professional Accounting

Level 7
Campus 
Starts Feb, Jul, Nov

Full time 1 year
Fees per year* NZ$18,900
IELTS 6.0

Level 7
Campus 
Starts Feb, Jul, Nov

Full time 1 year
Fees per year* NZ$18,900
IELTS 6.0

Level 7
Campus  
Starts Feb, Jul, Nov

Full time 1 year
Fees per year* NZ$18,900
IELTS 6.0

Level 7
Campus  
Starts Feb, Jul, Nov

Full time 1 year
Fees per year* NZ$18,900
IELTS 6.0

Level 7
Campus  
Starts Feb, Jul, Nov

Full time Up to 18 months
Fees* per year NZ$18,900
IELTS 6.0

Course content guide
> Organisational Behaviour
> Research Methods
> Project Management
> Strategic Management
> 30 credits of electives e.g. 

International Business or 
Operations Management 

> Advanced Applied 
Management

Use the Advanced Applied 
Management course to specialise 
in your area of interest.
Career outcomes: Management 
role in chosen industry.

Course content guide
Specialisms:
Information Security, Networking, 
Software Development, Database 
Administration or Information 
Systems.
All students must complete:
> Project Management
> Graduate Diploma Project

Refer to website for the complete 
listing of additional courses 
available.
Career outcomes: Security 
consultant, test analyst, data 
analyst, user experience designer, 
information technology manager.

Course content guide
> Marketing Management 
> Marketing Applications 
> Research Methods
> Project Management
> Strategic Marketing 

Management
> Buyer Behaviour and 

Marketing Research
> Advanced Applied Marketing

> 15 credits of electives e.g. 
Global Business Management, 
Advanced Operations 
Management

Career outcomes: Marketing 
and sales management, product 
management, merchandising, 
services marketing, market 
research, brand management 
and key account management.

Course content guide
> Introduction to Accounting 

and Taxation 
> Financial Accounting 
> Advanced Financial Reporting
> Management Accounting 
> Advanced Management 

Accounting 
> Advanced Accounting Project

> 15 credits of elective e.g. 
Financial Management, 
Advanced Taxation, Advanced 
Auditing

Career outcomes: Qualified to 
work in a range of accounting 
roles including financial 
accounting, management 
accounting and business 
consulting.

Course content guide
> Advanced Financial Reporting
> Advanced Management 

Accounting
> Advanced Accounting Project
> Financial Accounting
> Taxation

> Company Law
> Commercial Law
Career outcomes: A CA ANZ 
or CPA Australia qualified 
accountant. Roles include: 
Financial accounting, corporate 
management, taxation, auditing, 
business consultant.

Business

Information Technology

Please note: If you wish to become a 
Chartered Accountant or a Certified 
Practising Accountant you must submit 
your Bachelor’s Degree to Chartered 
Accountants Australia and New Zealand 
(CA ANZ) or Certified Practising Accountants Australia (CPA) who 
will inform you which courses you will need to study on the Graduate 
Diploma in Professional Accounting Programme. This process can take 
up to 12 weeks and you will need to pay a fee to these organisations. 
The completion requirements will vary for each student and be 
dependent on this information. 

In association with:
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Marlborough 
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Nelson 
Campus

Bachelor's Degrees and Diplomas

Bachelor of Commerce 
(Major in Marketing, Accounting or Management)

Level 7
Campus  
Starts Feb, Jul, Nov

Full time 
Fees per year* NZ$18,900
IELTS 6.0

Course content guide
The first year of the degree 
provides a solid foundation in:
> Accounting
> Economics
> Communications
> Law
> Management
> Human Resource 

Management
> Marketing 
> Quantitative Analysis
You can then specialise in your 
chosen area of accounting, 

management, marketing or a 
combination of these.
Career outcomes: Dependent 
on specialistion this may 
include: Marketing and 
sales management, product 
management, brand 
management, corporate 
management, taxation, auditing, 
business consultant.

Business

Our accounting major 
is accredited by:

3 years (single major)
3.5 years (double major)

New Zealand Diploma in Business (Level 5) 
(Leadership and Management) or (Accounting)

Level 5
Campus 
Starts Feb, Jul

Full time 1 year
Fees per year* NZ$18,900
IELTS 6.0

Pathway from this one year programme into 
the second year of the Bachelor of Commerce

Bachelor of Information Technology 
(Major in Information Systems, Systems  
Development or ICT Infrastructure)

Level 7
Campus 
Starts Feb, Jul

Full time 3 years
Fees per year* NZ$18,900
IELTS 6.0

Course content guide
The programme focuses on the 
following core courses:
> Database Concepts
> Professional Communications
> Networking Fundamentals
> Software Development
> Systems Development
> Systems Analysis and Design
> Internet Design Principles 
> Computer Systems 

Architecture 

Choose other courses 
based on what you 
major in:
> Information 

Systems
> Systems Development or 
> ICT Infrastructure
Career outcomes: IT role in 
industry majoring in specialist 
field (Information systems, 
development and ICT 
infrastructure).

Information Technology

New Zealand Diploma In Information 
Technology, New Zealand Diploma in Web 
Development and Design, New Zealand 
Diploma in Technology Technical Support

Level 5
Campus 
Starts Feb

Full time 1 year
Fees per year* NZ$18,900
IELTS 6.0

Study one of these one year programmes and 
pathway into the second year of the Bachelor of 

Information Technology

Bachelor of Aquaculture  
and Marine Conservation

Level 7
Campus 
Starts Feb

Full time 3 years
Fees per year* NZ$18,900
IELTS 6.0

Course content guide
> Aquatic Life Support Systems 

and Animal Husbandry
> Aquatic Biology
> Aquaculture Principles
> Te Tini a Tangaroa and 

Aquatic Ecology and Fishery 
Management

> Environmental Management
> Business Environment
> Research and Communication 

Skills

> Industry Practice 
> Health and Biosecurity 

Management
> Aquaculture and Marine 

Conservation Science
> Marine and Tropical 

Aquaculture
> Statistics and Experimental 

Design
Career outcomes: Aquaculture 
farmer, hatchery and nursery 
technician, marine biologist, 
marine scientist.

Marine Biology

Bachelor of Viticulture and Winemaking
Level 7
Campus 
Starts Feb, Jul

Full time 3 years
Fees per year* NZ$18,900
IELTS 6.0

Course content guide
> Business Environment 
> Āronga Māori and Viticultural 

Practices
> Wine Production
> Wine Chemistry and Analysis
> Plant Science
> Papatūānuku and Soil Science
> Industry Practice - Vineyard
> Research and Communication 

Skills
> Winery and Vineyard 

Engineering
> Vineyard Bio-protection
> International Wine Industry
> Operations Management
> Winery Technology and 

Design
Career outcomes: Viticulturalist, 
research and development 
technician, vineyard manager 
or owner, wine marketer 
or winemaker or assistant 
winemaker.

Viticulture and Winemaking

Career outcomes: IT role in industry majoring in specialist field.
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*Please refer to page 32 for our fees disclosure statement. **Subject to NZQA and TEC approval. 

Bachelor's Degrees and Diplomas continued

Bachelor of Computer 
Generated Imagery

Level 7
Campus 
Starts Feb

Full time 3 years
Fees per year* NZ$18,900
IELTS 6.0

Course content guide
> Professional Practice
> 3D Modelling
> Rigging and Animation
> Dynamic Effects
> Lighting and Post-production
> Technical Development

> CGI Project
> Real Time Lighting and 

Shading
Career outcomes: Game design, 
animation, digital interaction, film 
and television, special effects and 
technical development. 

Computer Generated Imagery

Bachelor of Nursing
Level 7
Campus 
Starts Feb

Full time 3 years
Fees per year* NZ$19,900
IELTS 6.5 (with 7.0 in listening subtest)

Course content guide
> Health and Wellness
> Interpersonal Relationships
> Management of Nursing Care
> Nursing the Person with Long 

Term Health Needs
> Nursing Science
> Professional Responsibilities
> Mental Health and Addictions
> Physical Heath
> Nursing the Person with 

Altered Mental Health or 
Addiction

> Contemporary Issues in 
Nursing and Health Care

> Family and Community 
Nursing

> Pharmacology for Nursing 
Practice

> Transition to Registered Nurse 
Practice

> Evidence for Nursing Practice
> Health Research
On completion of this programme 
you can apply to the Nursing 
Council of New Zealand for 
registration as a nurse. This gives 
you direct entry into the nursing 
profession following successful 
completion of the Nursing State 
Final Exam. Overseas nurses 
may be able to join the second 
year of this programme. Please 
contact international@nmit.ac.nz 
for more information.
Career outcomes: Nursing career 
across a range of hospital and 
community settings. Hospitals, rest 
homes, schools.

Nursing

New Zealand Diploma in Animation
Level 5 and 6
Campus 
Starts Feb

Full time 2 years
Fees per year* NZ$18,900
IELTS 6.0

Pathway from this two year programme into the final  
year of the Bachelor of Computer Generated Imagery

AUT Bachelor of Sport and Recreation
Level 7
Campus 
Starts Feb

Full time 3 years
Fees per year* Refer to website
IELTS 6.0

Course content guide
Build on skills obtained in the 
New Zealand Diploma in Sport, 
Recreation and Exercise (Level 6) 
with this degree, designed to 
address the increasing demand 
for skilled sport, recreation and 
health and fitness professionals.

Career outcomes: Aerobics 
instructor, athletic trainer, coach, 
community recreation advisor, 
exercise rehabilitation provider, 
gym instructor, manager of team/
facility, PE teacher, specialist 
sports advisor, sports trust 
worker, sports coordinator, team 
masseuse, team trainer.

Fitness

New Zealand Diploma in Sport, 
Recreation and Exercise (Multi-Sector)

Level 5 and 6
Campus 
Starts Feb

Full time 2 years
Fees per year* NZ$16,900
IELTS 6.0

On completion of this two year  
programme (Level 5 and 6), you can pathway  

into the AUT Bachelor of Sport and Recreation, run on 
the NMIT Nelson campus, and complete the degree with 

one more year of study

Bachelor of Arts and Media 
(Visual Arts and Design)

Level 7
Campus 
Starts Feb, Jul

Full time 3 years
Fees per year* NZ$18,900
IELTS 6.0

Course content guide
Gain a good foundation in arts 
and design, digital literacy, 
professional practice and 
communication in your first year, 
then specialise in your areas of 
interest in your second and third 
years. Subjects include:
> Image Making
> Design Fabrication
> Graphic Design
> Digital Photography
> Drawing
> Illustration

> Promotional Artwork
> Branding and Identity
> Video Practice and Process
> Animation
> Design for Mobile Devices
The Bachelor of Arts and Media 
culminates in the end of year 
exhibition where students present 
their final major project.
Career outcomes: Graphic 
designer, videorapher, gallery 
manager, website designer, visual 
artist.

Arts, Media and Design

New Zealand Diploma in Arts and Design

Level 5 and 6
Campus 
Starts Feb, Jul

Full time 2 years
Fees per year* NZ$18,900
IELTS 6.0

Pathway from this two year programme into 
the final year of the Bachelor of Arts and Media
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Bachelor of Career Development

Paetahi Tumu Kōrero Bachelor  
of Counselling

Bachelor of Social Work

Level 7
Campus 
Starts Feb

Full time 3 years
Fees per year* NZ$18,900
IELTS 6.5

Level 7
Campus 
Starts Feb

Full time 3 years
Fees per year* NZ$18,900
IELTS 6.5

Level 7
Campus 
Starts Feb

Full time 4 years
Fees per year* NZ$18,900
IELTS 6.5

Course content guide
> Aotearoa Society
> Careers Communication
> Knowing Self
> Human Development
> The Changing Nature of 

Careers
> Wānanga
> Employment Relations and 

Policy
> Careers in Context
> Integrated and Reflective 

Practice

> Skills and Models of Practice
> Assessment Tools and Career 

Practice
> Te Tiriti o Waitangi: 

Application and Practice
> Working with Vulnerable 

People
> Organisations and Human 

Capability
> Cultural Communication
> Research Project
Career outcomes: Career 
guidance, professional 
practitioner.

Course content guide
> Professional Counselling 

Practice
> Human Development and 

Psychology
> Introduction to Society
> Counselling Theory and 

Practice
> Treaty of Waitangi Based 

Practice
> Mental Health and Addictions
> Working with Family, Children 

and Young People
> Counselling Change and 

Wellbeing in Practice
> Law, Ethics and Policy
> Development of Counselling 

Practice
> Research and Professional 

Practice
Career outcomes: Work in a 
range of social services, mental 
health, and other counselling 
related roles.

Course content guide
> Social Work Practice
> Human Development and 

Psychology
> Introduction to Professional 

Practice
> Introduction to Social 

Research
> Applied Social Research
> Applied Social Work Practice 

with Groups and Communities

> Social Work Practice with 
Individuals and Family

> Acute and Complex Care in 
Mental Health and Addictions

> Social Work Practice in 
Specialist Fields

Career outcomes: Social worker 
across government organisations 
including health and not for profit 
social service agencies.

Social Sciences

Diploma in Interior Design
Level 5
Campus 
Starts Feb

Full time 1 year
Fees per year* NZ$18,900
IELTS 6.0

Course content guide
The Diploma in Interior Design will 
provide you with a comprehensive 
foundation in interior design with 
a specific focus on skills and 
industry knowledge required 

in the development and 
communication of interior design.
Career outcomes: Interior 
designer, design stylist, visual 
merchandiser, colour consultant, 
design stylist.

Interior Design

New Zealand Diploma in  
Contemporary Music

Level 5
Campus 
Starts Feb

Full time 2 years
Fees per year* NZ$18,900
IELTS 5.5

Course content guide
Through this programme you will 
complete compulsory courses 
across levels 4 and 5 in sound 
production, contemporary music 
performance, contemporary 
music studies, instrument practice 

and performance.
Career outcomes: Musician, music 
tutor, sound technician, radio 
presenter, media producer, music 
retailer, production assistant.

Contemporary Music

New Zealand Diploma in Engineering 
(Civil Engineering)

Level 6
Campus 
Starts Feb

Full time 2 years
Fees per year* NZ$18,900
IELTS 6.0

Course content guide
> Engineering Fundamentals
> Technical Literacy
> Materials (Civil)
> Land Surveying
> Structures
> Civil and Structural Drawing

> Geotechnical Engineering
> Highway Engineering
> Engineering Mathematics
> Hydraulics (Civil)
> Engineering Project
> Engineering Management
> Water and Wastewater 

Systems

Civil Engineering
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New Zealand Certificate in Study 
and Career Preparation

Level 4
Campus 
Starts Feb, Jul

Full time 19 weeks
Fees* NZ$8,450
IELTS 5.5#

Course content guide
Individually tailored courses let 
you focus on the skills you need 
to learn for your future, whether 
you want to study nursing, social 
sciences, business, art or IT. 

Health pathway
> Nursing
Counselling and Social Work 
pathway
> Counselling
> Social Work
Open pathway
> All other programme areas

If your high school qualification is not high enough to get 
direct entry to NMIT’s Bachelor Degrees and Diplomas, you 
may be eligible to gain entry to the New Zealand Certificate 
in Study and Career Preparation. With meeting English entry 
requirements and successful completion of this one semester 
qualification you may pathway into further NMIT study.  
For entry requirements by country please see page 28.

Foundation Programmes
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English Language

Level 1-5
Campus 
Starts Mar, May, Jul, Sep, Nov

Full time 16 weeks per level
Fees* NZ$6,000 per NZCEL level or $375 per week
IELTS Any

New Zealand Certificate in English Language (NZCEL)

English Language

Pathway directly 
from English studies 
into your chosen 
programme of 
study for example:

Foundation

NZCEL Level 1 NZCEL Level

1
NZCEL Level

2

Level 3 
Certificates

NZCEL Level

General

3

Level 4 
Certificates

NZCEL Level

Applied

3

Level 5-6 
Certificates 

and 
Diplomas

NZCEL Level

General

4

Level 6 or 
7 diploma, 
degree or 
graduate 
certificate

NZCEL Level

Academic

4

Degrees 
requiring 

higher entry, 
Postgraduate 
qualifications

Academic

NZCEL Level

5

See page 20 for English Language Pathway Scholarships information

*Please refer to page 32 for our fees disclosure statement

> Study in the beautiful, sunny Nelson region on the inner city Nelson campus
> Immerse yourself in the friendly local culture

You can take our English classes on their own OR pathway on to further study at NMIT.
Our highly qualified and very experienced tutors will help you to improve your English for 
daily life, work or study. We encourage you to be an active learner inside and outside  
the classroom.
Each Certificate level takes 16 weeks and can increase your IELTS score by the 
equivalent of 0.5.
On your first day as a student at NMIT you complete an English language assessment 
which helps us to identify your level of study and ensure your learning needs are met.  
This helps plan the best study path for you.

February
Pathway into 

Master of Applied 
Management

September 

Study New Zealand 
Certificate in 

English Language 
(Academic) Level 5

16 weeks study
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Specialist Qualifications

New Zealand Diploma  
in Marine Engineering 
STCW Engineering Officer of the Watch (EOOW) III/1

New Zealand Diploma in Nautical 
Science STCW Officer of the Watch (OOW) II/1

New Zealand Certificate in Maritime 
Crewing (Level 4) STCW AB Deck

Certificate in Superyacht Crewing

Level 6
Campus 
Starts Feb, Aug

Full time 30-36 weeks 
Fees* NZ$19,900
IELTS 6.0

Level 6
Campus 
Starts Feb

Full time 36-43 weeks 
Fees* NZ$16,900 - $23,399
IELTS 6.0

Level 4
Campus 
Starts Jan

Full time 17 weeks 
Fees per year* NZ$8,782
IELTS 5.5

Level 3
Campus 
Starts Feb, May, Aug

Full time 12 weeks 
Fees* NZ$8,500
IELTS 5.0

Entry requirements
Completion of an approved 
Training Record Book and 
evidence of sea-time (see  
www.maritime.govt.nz for details) 
Course content guide
Marine Engineering courses
> Mathematics
> Applied Mechanics
> Thermodynamics
> Hand Tools and Workshop Skills
> Electrical, Electronics 

and Control Engineering 
- Operational and 
Maintenance/Repair

> Main Machinery Systems
> Auxiliary Machinery Systems
> High Voltage Vessel Systems - 

Operational
> Engine Room Watchkeeping
> Marine Engineering Workplace 

Practicum
> Leadership and Teamwork
Also includes
> STCW Basic Safety Training
> STCW Proficiency in Survival 

Craft
> STCW Medical First Aid
> STCW Advanced Firefighting
> Ship Construction
> Ship Stability
> Maritime Legislation
Students from OERC in India can 
benefit from Recognition of Prior 
Learning for this programme.  
See oercedu.com
Career outcomes: Engineer 
officer of the watch on merchant 
navy vessels of any size and 
propulsion power, anywhere in 
the world.

Entry requirements
Completion of an approved 
Training Record Book and 
evidence of sea-time (see  
www.maritime.govt.nz for details) 
Course content guide
Nautical Science courses
> Navigational Mathematics
> Navigational Physics
> Introduction to Meteorology
> Navigation Offshore
> Passage Planning
> Cargo Handling and Stowage
> Compass Navigation
> Bridget Watchkeeping - OOW
> Vessel Operations OOW
> Officer of the Watch Tasks
> Officer of the Watch 

Assignments
> Electronic Chart Display 

Information Systems
> Electrical Navigation Aids

> Global Maritime Distress and 
Safety

> HELM
> Ocean Meteorology
> Celestial Navigation and Tides
> Radar and ARPA
Also includes
> STCW Basic Safety Training
> STCW Proficiency in Survival 

Craft
> STCW Medical First Aid
> STCW Advanced Firefighting
> Ship Construction
> Ship Stability
> Maritime Legislation
Students from OERC in India can 
benefit from Recognition of Prior 
Learning for this programme. See 
oercedu.com
Career outcomes: Officer of the 
watch (deck) on foreign-going 
ships.

Entry requirements
Completion of an approved 
Training Record Book and 
evidence of sea-time (see  
www.maritime.govt.nz for details) 
Course content guide
Compulsory Able Seafarer Deck 
courses
> Navigation
> Seamanship
> Cargo Operations
> Maintenance and Repair
> Health Safety and Pollution 

Prevention
Compulsory STCW courses

> STCW Basic Safety Training
> STCW Proficiency in Survival 

Craft
Elective courses
> Able Seafarer Engine 

Watchkeeping
> Able Seafarer - Engine 

Operations
> Able Seafarer - Electrical
> Electro-technical Rating – 

Monitoring Electrical Systems
> Electro-technical Rating – 

Maintenance and Repair
Career outcomes: Crew member 
within your speciality area of 
either deck or engineering.

Course content guide
Nelson, with its busy port 
and thriving boat culture, is a 
great place to gain the skills 
in seamanship and hospitality 
you need to work in the global 
superyacht industry. You will 
learn a wide range of skills 
including navigation, seamanship, 
powerboat training and 
hospitality.

Exclusive to our superyacht 
programme is a three-day 
motor boat and five-day sailing 
yacht trip as well as a three-day 
powerboat training course, where 
you can put into practice what 
you learn.
Career outcomes: Work as crew 
general, commercial, passenger or 
superyachts.

Maritime short courses
NMIT offer STCW and Refresher 
training through the International 
Maritime Institute of New Zealand.
You can do your STCW Basic 
Training with us, or take individual 
short courses.
Course content guide
> Electronic Chart Display and 

Information Systems (ECDIS)
> General Radio Telephone 

Operators Certificate (GRTOC)
> Global Maritime Distress and 

Safety Systems (GMDSS)
> International Safety 

Management
> Maritime Restricted Radio 

Operators (RRTOC) (MROC)
> Advanced Fire Fighting and 

Refresher

> Fire Prevention and Fire Fighting
> Basic Fire Fighting Refresher
> Elementary First Aid
> Proficiency in Medical First Aid
> Fast Rescue Boat and Refresher
> High Voltage – Management
> High Voltage – Operational
> Personal Safety and Social 

Responsibilities (PSSR)
> Personal Survival Techniques 

(PST) Survival Course and 
Refresher

> Proficiency in Survival Craft 
(PISC) and Refresher

> Seafarer Security Awareness
> Tanker Basic Operations - Oil 

and Chemical
> Stability Upgrade
Find out more at iminz.ac.nz

Upon completion of an IMINZ qualification, you will need to submit an application to Maritime New Zealand 
(MNZ) to receive your Certificate of Competency. Please visit maritimenz.govt.nz for more information.

Marine



RNZAF Base
Woodbourne

Marlborough 
Campus

Nelson 
Campus*Please refer to page 32 for our fees disclosure statement. **Subject to TEC/NZQA approval. This programme is undergoing a review as part of the NZ Tertiary Review of Qualifications. 

Some details about this programme may change, so please see our website for the most up to date information.

Culinary Arts
(New Zealand Diploma in Cookery (Advanced)) (Level 5)

New Zealand Certificate in 
Aeronautical Engineering

New Zealand Diploma in 
Beauty Therapy**

Certificate in Nursing 
(Competence Assessment Programme)

Diploma in Adventure Tourism  
and Guiding (New Zealand Diploma in  
Outdoor and Adventure Education)

New Zealand Certificate in Tourism 
(Operations)

Culinary Arts
(New Zealand Certificate in Cookery) (Level 4)

Level 5
Campus 
Starts Feb

Full time 1 year
Fees per year* NZ$19,900

IELTS 5.5

Level 4
Campus 
Starts Feb, Jul

Full time 2 years 
Fees per year* NZ$19,900
IELTS 6.0

Level 5
Campus  
Starts Feb

Full time 2 years 
Fees per year* NZ$18,900
IELTS 5.5

Level 7
Campus 
Starts Feb, May, Aug

Full time 12 weeks
Fees* $9,750
IELTS 7.0

Level 5
Campus 
Starts Feb

Full time 2 years 
Fees per year* NZ$18,900
IELTS 5.5

Level 4
Campus 
Starts Jul

Full time 19 weeks 
Fees* NZ$8,450
IELTS 5.5

Level 4
Campus 
Starts Feb, Jul

Full time 1 year
Fees per year* NZ$19,900
IELTS 5.5

Course content guide
A year of challenging projects 
both in and out of the kitchen. 
You will master the techniques 
and presentations required to 
work at the highest level in New 
Zealand or overseas. You will 
develop your understanding 
of global cuisine, sustainability, 

artisan foods, advanced meat, 
poultry and fish, menu design and 
restaurant production. You will 
also be involved in event catering 
as well as undertake an industry 
placement.
Career outcomes: Chef, cook, 
restaurant manager, artisan food 
business owner, kitchen hand.

Course content guide
> Introduction to General 

Aviation
> Introduction to Aircraft 

Systems
> Aircraft Structures Preparation
> Aircraft Fluid and Mechanical 

Systems
> Aircraft Structures-

Maintenance Practices
> Aircraft Systems – 

Maintenance Practices

> Aircraft Systems – Avionics
> Aircraft Systems – Population
> Aircraft Maintenance and 

Servicing
Please note that it is a RNZAF 
security requirement that you 
must be in New Zealand for six 
months before the start of the 
programme.
Career outcomes: Aeronautical 
engineer in the aviation industry.

Course content guide
> Facial Treatments
> Nail Services
> Waxing Services
> Eye Works and Tanning
> Make Up Services
> Anatomy and Physiology 
> Professional Practice
Gain practical work experience 
through providing services and 
treatments to clients in the  

on-campus beauty salons in 
Nelson and Marlborough.
Career outcomes: Beauty 
therapist, make-up artist, 
nail technician, waxing and 
electrolysis technician, massage 
therapist, beauty therapy sales 
technician beauty therapy 
pharmacy sales technician, make-
up for television and film, beauty 
therapy educator.

Course content guide
> Concepts Related to Nursing 

in the NZ Context
> Competence Assessment in 

Clinical Practice
Career outcomes: Graduates, 

once they have been issued with 
a practising certificate by the 
Nursing Council of New Zealand, 
are able to practice evidence-
based person centred care at 
a beginning level in a range of 
clinical settings.

Course content guide
Call the top of the South Island 
your classroom. Take advantage 
of our unique location, with 
three national parks nearby you 
will spend more time out of the 
classroom than in it. Gain the skills 
you need to become a guide in 
the Adventure Tourism industry.
> Advanced adventure guiding
> Rafting
> Sea kayaking

> River kayaking
> Snowboarding
> Rock climbing 
> Hiking
> Risk management
> Customer communications
Career outcomes: Outdoor 
recreation guide or instructor 
in the field of; rafting, kayaking, 
hiking/tramping/bush walking, 
snowboarding or skiing and rock 
climbing.

Course content guide
Nelson is the perfect place to 
gain a tourism qualification. As 
part of the programme, you will 
have real world experiences in 
this unique region of New Zealand 
with three national parks and a 
growing tourism and travel sector.

Career outcomes: Conference 
and events organisation, 
services and sales consultant 
for tourism office, travel agency 
sales consultant, customer 
service for tourism operators, 
customer service in airline 
industry or customer service in 
accommodation industry.

Course content guide
Guided by our highly experienced 
tutors you will develop the skills 
and techniques to be able to 
produce exciting cuisine. You will 
learn all aspects of preparation 
and production using a range 
of ingredients such as grains 
and rice, meat and poultry, 
seafood, bakery and desserts. On 

completion of this 
programme, you can 
undertake further 
study in Culinary Arts 
Level 5.
Career outcomes: 
Chef, cook, 
restaurant manager, artisan food 
business owner, kitchen hand.

Culinary Arts Aviation

Beauty Therapy

Nursing

Tourism

This programme is for you if you are an Internationally Qualified Nurse 
(IQN) or you were registered in New Zealand but you have been out 
of practice for 5 years or more.

Tourism and Hospitality Management Diploma 
coming in 2020.

Sustainable Aquaculture**:
Certificate in Aquaculture (Level 3, 4)

NZ Certificate in Seafood with strand in Aquaculture (Level 5)
For more information, see nmit.ac.nz

Look out for:
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NZ$3,000 scholarship available##

If you enrol on a Bachelor's Degree or the Diploma in Engineering (Civil) by December 2020.
##For each year of your Bachelor degree a NZ$1,000 scholarship will be credited to a NZ bank account. See NMIT website for details.

English Language Pathway Scholarships#

> 16 weeks free English for students who pathway onto our Bachelors, Degrees or Civil 
Engineering Diploma

> 50% off 16 weeks of English for students who pathway onto a full year of academic study
#These offers cannot be combined or used with any other scholarships at NMIT. Conditions apply. See NMIT website for details.



Complete part of your degree 
study overseas at one of our 
partner universities.

Our partner institutes
Denmark
> Copenhagen School of Design and Technology (KEA)
France
> ECE-BBA INSEEC Business School
Germany
> Cologne Business School
> Duale Hochschule Baden-Württemberg
> European University of Applied Sciences
> Frankfurt University of Applied Sciences
> Hochschule Worms University of Applied Sciences
Netherlands
> Fontys University of Applied Sciences
Norway
> University of Adger
> Nord University
Japan
> Aoyama University
> Kanagawa University
USA
> Humboldt State University
> University at Albany
> ISEP International Student Exchange Program
> Champlain College

Whilst you are completing part of your degree 
at an NMIT partner university you will only 
need to pay your normal NMIT tuition fees.

Choose to study a 
Bachelor programme 
at NMIT and you can 
study overseas on our 
Student Exchange 
programme in your 
second or third year.

International 
Student Exchange
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Student 
services
The Information and Enrolment Centre
The Information and Enrolment Centre provides  
centralised processing of applications, enrolments, 
re-enrolments, withdrawals, transfers and refunds for 
students. The team can also assist with visa applications 
and medical or travel insurance. They can be contacted 
at international@nmit.ac.nz. 

International student orientation
When you arrive at NMIT you will meet student services 
staff who will help you settle into your new city and your 
studies at NMIT.
The student advisor will accompany you on a campus 
tour and introduce you to the student association and 
key members of staff. 
You will also be given an orientation of your new local 
area. We can help you to set up a bank account. You’ll 
be shown where the doctor and police station are 
located as well as shops and other important services.
Orientation sessions also cover:

> Job search advice
> 'Kiwi' culture
> New Zealand Police and the law
> Driving regulations and owning a car.

International student support
NMIT's International Student Advisors are on hand to 
assist you with the following:

> Adjustment to student life
> Connections to people of your culture
> Balancing your study with work and family 

commitments
> Pacific Island support
> Relationship issues

> Access to free off-campus counselling (translation 
services available) through ocp.co.nz

> Referrals to community and government agencies
> Health concerns and medical referrals.

The International Student Advisors team have an emergency 
phone number so you can contact someone for support at 
any time, day or night.

Learning support
Learning Facilitators are here to advise and assist you with 
any aspect of your learning. 
They are located in the Te Puna Matauranga Library 
Learning Centres on the Nelson and Marlborough 
campuses. You can make an appointment to see them by 
emailing studentsupporthelp@nmit.ac.nz. 
The team offers one-to-one training as well as a range of 
seminars or small group training sessions.
Their aim is to help students to become independent 
effective learners.
Our Learning Facilitators can help you with:

> Computer skills
> Interview training
> CV writing
> Maths
> Learning styles
> Writing skills
> Planning essays or assignments
> Time management
> Research skills.

IT support
NMIT provides your own email address, campus wide WiFi, 
a personal login for computers around campus and IT 
help service for all students. You can access advice and 
assistance regarding all the usual IT requirements such as 
logins, passwords and printing.
If you need IT support, you can call free from your mobile 
phone, or use one of the on-campus Help Point phones. 
This is in addition to our IT Helpdesk service station, located 
at the main desk of the Library Learning Centre (LLC).

Graduating
Graduations are the most important days in NMIT’s 
calendar. 
The ceremonies are recognition of your achievement 
and hard work, combining academic formality with the 
celebration of you as a graduate, your families and friends. 
NMIT has graduation ceremonies in Nelson, Marlborough 
and on our local Marae for our Te Toki Pakohe students.

U.S. Department of veteran affairs
NMIT welcome students funded through the Post-9/11 GI Bill. 
Find out more at va.gov/education/about-gi-bill-benefits/
post-9-11/or contact us by emailing international@nmit.ac.nz.



Budgeting advice
Ask for advice
Your friendly International Student Support team are on 
hand to offer advice on budgeting and saving in New 
Zealand or you can contact the student association, 
SANITI for free independent advice.

Get a discount
As a Student Identity Card holder, you are entitled to 
a range of discounts in local businesses from cinema 
tickets to food and clothes.

Further support
New Zealand wants to welcome you and make sure you 
have the resources you need to enjoy your time here. 
Find out more about New Zealand wide support services 
at immigration.govt.nz/assist-migrants-and-students/
assist-students

Costs and 
budgeting advice
Before you begin your studies at NMIT, 
there are some important things you 
need to know about life as a student in 
New Zealand.

Working and study
As an international student in New Zealand your visa 
may allow you to work up to 20 hours a week and full 
time during the holidays.
The main purpose of a student visa is to allow 
international students to study full time in New Zealand. 
However, depending on your study programme you may 
have an opportunity to work while you study.
Many students find part time employment in the 
hospitality and service industries including restaurants, 
bars and supermarkets.
In New Zealand there are laws to protect our workers, 
and this includes international students. Find out more 
about your rights and responsibilities working in New 
Zealand at immigration.govt.nz.
For those eligible to work, the following websites can be 
very helpful:

> seek.co.nz
> trademe.co.nz
> sjs.co.nz (Student Job Search).

The current adult minimum wage rates (before tax) that 
apply for employees aged 16 or over are: NZ$17.70 an 
hour, which is NZ$354 for a 20 hour week, or NZ$708 for 
a 40 hour week.

Cost comparisons

NZ$8

NZ$2

NZ$120 NZ$16-40

NZ$2.20

NZ$16 NZ$3

Big Mac

Bottle of Coke (1.5 litre)

Pair of Levi jeans Going out for dinner

Petrol per litre

Movie tickets Rice 1kg

NZ$10

NZ$10-20

Shuttle fare - airport to Nelson

Takeaway meal 

We have picked a few items to give you an understanding of 
some day to day costs in New Zealand (approximate costs):
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Helpful information
Immigration New Zealand
The type of visa you will receive will depend on the 
duration of the programme. Please refer to Immigration 
New Zealand's website for further information.
Full details of immigration requirements, advice on rights 
to employment in New Zealand while studying, and 
reporting requirements are available from Immigration 
New Zealand, and can be viewed on their website at 
immigration.govt.nz.

Medical and travel insurance
International students, including groups of students, 
must have appropriate and current medical and travel 
insurance while in New Zealand.
NMIT will automatically arrange insurance cover for all 
students.
Students may choose their own insurance company, 
however it must comply with the minimum standards 
required by the Code of Practice for the Pastoral 
Care of International Students. If you arrange your 
own insurance cover, you must supply your Certificate 
of Insurance and Schedule of Cover, in English, to 
the Information and Enrolment Centre before the 
programme start date, email international@nmit.ac.nz. 
Once the insurance policy is evaluated and confirmed 
as meeting the minimum standards required by the Code 
of Practice for Pastoral Care, the policy taken out by 
NMIT on behalf of the student will be cancelled with the 
insurance fees refunded to the student.
Insurance cover must be to the length of your visa.

Eligibility for health services
Most international students are not entitled to publicly 
funded health services while in New Zealand. If you 
receive medical treatment during your visit, you may 
be liable for the full costs of that treatment. Full details 
on entitlements to publicly funded health services are 
available through the Ministry of Health, and can be 
viewed on their website at moh.govt.nz.

Accident insurance
The Accident Compensation Corporation provides 
accident insurance for all New Zealand citizens, 
residents, and temporary visitors to New Zealand but you 
may be liable for all other medical and related costs. 
Further information can be viewed on the ACC website 
at acc.co.nz.

2020 Academic year
NOTE: Some programmes start on unique dates, 
for more information visit nmit.ac.nz.

Terms
Some programmes have 5 x 8 week terms, per 
year. Term start dates:

> Term 1 24 February 2020
> Term 2 4 May 2020
> Term 3 13 July 2020
> Term 4 21 September 2020
> Term 5 30 November 2020

Semester
Some programmes have 2 x 16 week semesters, 
per year. Semester start dates:

> Semester 1 24 February 2020
> Semester 2 20 July 2020
> Semester 3 30 November 2020 (Summer School) 

(8 weeks)



NMIT International Student Support team can provide 
support in finding accommodation while you study. 
We also provide an airport pick-up service for all 
international students.
If you require on-campus accommodation or commercial 
accommodation, i.e. backpacker hostel or private rooms, 
we can advise on suitable providers. You will need to 
book with them directly. 

Homestay
> Full homestay - NZ$280

> Independent homestay - NZ$215

> Administration fee - NZ$200
In a homestay organised by NMIT you can expect to:

> Live with a New Zealand family in your own 
furnished room and become part of the family.

> Improve and practise your English 
> Learn new cultural experiences
> Full Homestay includes breakfast, dinner and lunch 

on weekends
> Independent Homestay, buy and cook your own food
> Internet included
> Homestay families are selected in accordance with 

the New Zealand Code of Practice for the Pastoral 
Care of International Students

> Under-18 homestays include breakfast, lunch and 
dinner. International students under 18 years of age 
are required to stay in approved under-18 homestay 
accommodation. Contact us for more details about 
under-18 homestay accommodation.

Please note: Homestay accommodation is subject  
to availability. NMIT charge a non-refundable  
NZ$200 administration fee to all homestay students.  
Contact our International Student Support team  
to find about homestay availability by emailing  
internationalsupport@nmit.ac.nz

Rent a room/house
Many students decide to rent a house or room with 
friends and fellow students. On arrival, the student 
support team is able to provide you with a list of 
websites and rental agencies for you to arrange your 
own accommodation. 
The cost of renting a room varies between Nelson 
and Marlborough. The cost can range from NZ$150 
to NZ$300 per room plus bills (electricity, telephone, 
internet and food).
All accommodation options is subject to availability. 
NMIT recommends securing accommodation as soon as 
possible. Nelson's busiest period for accommodation is 
December-February.

Accommodation
Backpacker hostel and private rooms
> NZ$30 - 150+ per night
To book these you will need to access their websites 
directly. The providers require a credit card deposit. 
NMIT cultural advisors can advise on suitable providers 
and the different options available.
Hostel prices vary with location and facilities provided. A 
shared room with shared facilities will cost a minimum of 
NZ$30 per night.

Apartment living 
Apartment accommodation options are independently 
owned and operated.
Nikau Apartments in Nelson

> From NZ$155 - 210 per week
At Nikau Apartments in Nelson you will

> Live with other students in one, two, three or four 
bedroom apartments

> Convenient access to your classes and the Library 
Learning Centre

> Just a two minute walk to the city
> Modern, comfortable and student-friendly
> Your own furnished apartment with a bathroom and 

a fully equipped kitchen to cook your own food
> Shared power, laundry and internet (costs are 

additional)
> 14 apartments in three blocks (42 apartments 

available).

Find out more and book directly online at 
nikauapartments.co.nz

FREE AIRPORT PICKUP from Nelson Airport 
Let us know when you are arriving 
at least five days beforehand, and we can organise a airport pickup 
for you nmit.ac.nz/airport-transfer
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http://www.nzqa.govt.nz/about-us/our-role/legislation/nzqa-rules/nzqf-related-rules/the-table/

1  The listed outcomes represent the minimum scores or grades for each test or qualification that qualify a student for enrolment at each programme level. Students with higher scores or 
grades than required for a particular programme level may still enrol at that level.

2  IELTS scores used must be taken from a single IELTS Test Report Form (i.e. combining scores from more than one test is not permissible).
3  New versions of some NZCEL qualifications, and in some cases new qualifications, were published on 13 June 2017. These are intended to replace pre-existing versions and qualifications, 

which have been given expiring status until discontinued on 31 December 2019.
4  Other tests may be accepted and entry requirements are subject to change. See the website above for the latest entry requirements.

EXCEPTIONS
Pathway programmes onto higher levels require IELTS score for the higher level programme.

English entry 
requirements 

English Proficiency Outcomes1

Internationally  
recognised  
proficiency tests

IELTS test2 TOEFL 
Internet-
based 
test 
(iBT)

Cambridge 
English 
Examinations

NZCEL3 Pearson 
Test of 
English 
(Academic)

LanguageCert Trinity ISE

Certificate at Level 3 General or 
Academic 
score of 5
with no band 
score lower 
than 5

Score of 
35 (with 
a writing 
score of 
20)

FCE or FCE for 
Schools with a score 
of 154. No less than 
154 in each skill. 
OET at Grade C in 
all sub-tests

Level 3 
(General) or 
(Workplace) 

PToE 
(Academic) 
score of 36 
with no band 
score lower 
than 36

B1 Achiever IESOL 
(LRWS) with PASS and 
no less than Pass in 
each skill 

ISEI with no 
less than 
distinction 
in any band

Certificate at Level 4 General or 
Academic 
score of 5.5
with no band 
score lower 
than 5

Score of 
46 (with 
a writing 
score of 
20)

FCE or FCE for 
schools with a score 
of 162. No less than 
154 in each skill.
OET at Grade C in 
all sub-tests

Level 3 
(Academic) 
or (Applied)

PToE 
(Academic) 
score of 42 
with no band 
score lower 
than 36

B2 Communicator 
IESOL (LRWS) with PASS 
and no less than Pass in 
each skill

ISEII with 
no less than 
pass in any 
band

Certificate at Level 5 Academic 
score of 5.5
with no band 
score lower 
than 5

Score of 
46 (with 
a writing 
score of 
20)

FCE or FCE for 
schools with a score 
of 162. No less than 
154 in each skill.
OET at Grade C in 
all sub-tests

Level 4 
(General) or 
(Workplace) 
or 
(Employment) 

PToE 
(Academic) 
score of 42 
with no band 
score lower 
than 36

B2 Communicator 
IESOL (LRWS) with 
HIGH PASS and no less 
than Pass in each skill

ISEII with 
no less than 
merit in any 
band

Certificate or Diploma  
at Level 6 
Graduate Diploma or  
Degree at Level 7

Academic 
score of 6
with no band 
score lower 
than 5.5

Score of 
60 
(with a 
writing 
score of 
20)

FCE, or FCE for 
schools, or CAE, or 
CPE with a score 
of 169. No less than 
162 in each skill.
OET at Grade C in 
all sub-tests

Level 4 
(Academic)

PToE 
(Academic) 
score of 50 
with no band 
score lower 
than 42

C1 Expert IESOL (LRWS) 
with PASS and no less 
than Pass in each skill 

ISEII with 
no less than 
distinction 
in any band

Postgraduate Diploma or 
Postgraduate Certificate at 
Level 8  
Master’s Degree at Level 9

Academic 
score of 6.5
with no band 
score lower 
than 6

Score of 
79 
(with a 
writing 
score of 21)

CAE or CPE with a 
score of 176. No less 
than 169 in each 
skill.
OET at Grade B in 
all sub-tests

Level 5 
(Academic) 
or 
(Professional) 

PToE 
(Academic) 
score of 58 
with no band 
score lower 
than 50

C1 Expert IESOL (LRWS) 
with HIGH PASS and no 
less than Pass in each 
skill or C2 Mastery 
IESOL (LRWS) with PASS 
and no less than Pass in 
each skill

ISEIII with 
no less than 
pass in any 
band

NMIT Programme of study IELTS Academic Score Required
Bachelor of Nursing 6.5 (no lower than 6.5 in speaking, reading and writing subtests and 7.0 in listening subtest)

Certificate in Nursing (Competence Assessment Programme) 7.0
Paetahi Tumu Kōrero Bachelor of Counselling 6.5
Bachelor of Social Work 6.5
New Zealand Certificate in Aeronautical Engineering 6.0
Diploma in Aquaculture (Fish Farming and Fishery Management) 5.5



Entry requirements guide

Country Certificate and Diploma Programmes  
(Equivalent entry to New Zealand NCEA Level 1 or 2)

Degree Programmes  
(Equivalent entry to New Zealand NCEA Level 3)

Brazil Certificado de Ensino Médio. Successful completion of one year’s tertiary study at a recognised 
institution.

Canada Grade 11 Secondary School Diploma (general level). High School Graduation Diploma or Senior Secondary Graduation 
Diploma.

China Senior High School Graduation Certificate with a minimum 
of 70%. 

Senior High School Graduation Certificate with B average. 

Fiji Fiji School Leaving Certificate. Form 7 Examination or successful completion of one year of tertiary 
study at a recognised institution.

France Please contact international@nmit.ac.nz for more 
information.

Baccalauréat or successful completion of one year of tertiary study at 
a recognised institution.

Germany Realschulabschluss / Mittlere Reife. Zeugnis der Allgemeinen Hochschulreife / Abitur or successful 
completion of one year of tertiary study at a recognised institution.

Hong Kong Hong Kong Certificate of Education or Diploma of 
Secondary Education.

Hong Kong Advanced Level Certificate / Diploma of Secondary 
Education or successful completion of one year of tertiary study at a 
recognised institution.

India Higher Secondary Certificate / Standard 12. Higher Secondary Certificate / Standard 12.

Indonesia Surat Tanda Tamat Belajar -Sekolah Menengah Umum 
Tingkat Atas (STTB - SMA) 

Completion of Sekolah Menengah Atas (SMA) with aminimum score 
of 8

Japan Upper Secondary School Leaving Certificate (Kotogakko 
Sotsugyo Shomeisho).

 Completion of a High School Diploma with a B average

Korea High School Diploma. Junior College Diploma or completion of High School Leaving 
Certificate..

Malaysia SPM (Sijil Pelajaran Malaysia - Malaysia Certificate of 
Education).

Three passes in STPM exam at C or better; or A maximum score of 18 
points over 6 academic subjects in the UEC; or Three Advanced Level 
passes at grade C or better; or Successful completion of an Australian 
Matriculation programme with an ATAR of at least 75; or Successful 
completion of a Canadian Matriculation programme with an average 
of 65% across six subjects in Grade 12.

Nepal Proficiency Certificate / Intermediate Examination/ 
Higher Secondary Certificate.

Successful completion of one year’s tertiary study at a recognised 
institution.

Oman Shahadat Al-Thanawaya Al-Aama (General Secondary 
Education Certificate).

Successful completion of one year’s tertiary study at a recognised 
institution.

Pacific Islands Successful completion of Year 12 (6th form). Successful completion of Year 13 (7th form) or successful completion of 
one year of tertiary study at a recognised institution.

Philippines High School Diploma (Grade 12) Arts and Design/Sports 
Track

High School Diploma (Grade 12) Academic Track 

Russia Аттестат о среднем (полном) общем образовании, 
Certificate of Secondary (Complete) General Education.

Successful completion of one year’s tertiary study at a recognised 
institution.

Saudi Arabia Tawjihiyah (General Secondary Education Certificate). Successful completion of one year’s tertiary study at a recognised 
institution.

South Africa Senior Certificate. Successful completion of one year’s tertiary study at a recognised 
institution.

Sri Lanka Sri Lankan General Certificate of Education (‘O’ Level or 
AS Level).

Sri Lankan General Certificate of Education (A Level).

Sweden Slutbetyg fran Grundskola. Avgångsbetyg / Slutbetyg från Gymnasieskola or successful 
completion of one year of tertiary study at a recognised institution.

Taiwan Senior High School Leaving Certificate. Junior College Diploma or successful completion of one year’s tertiary 
study at a recognised institution.

Thailand Certificate of Secondary Education / Maw 6. Certificate of Secondary Education / Maw 6.

United Kingdom General Certificate of Secondary Education (GCSE). Advanced Level (A Level).

USA High School Graduation Diploma. High School Graduation Diploma with SAT or successful completion of 
one year of tertiary study at a recognised institution.

Vietnam Upper Secondary School Graduation Diploma. Successful completion of one year’s tertiary study at a recognised 
institution.

The following table provides general academic entry information for students from different countries. Please note that the 
information provided is a guideline only and may be subject to change. Minimum grades apply.

Applicants to NMIT’s graduate diploma or postgraduate diploma programmes must have an undergraduate degree in any discipline.

NOTE: If your country or qualification is not listed above, please contact international@nmit.ac.nz for assistance or check the full list on our website.
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Programme guide

Programme Level Full time Start date IELTS Fees per year* (NZ$) Campus
English Language and Foundation
New Zealand Certificate in English 
Language

 1 to 
5

16 weeks Mar, May, Jul, 
Sep, Nov

Open NZ$6,000  
(NZ$375 per week)

Nelson

New Zealand Certificate in Study and 
Career Preparation

4 19 weeks Feb, Jul 5.5 NZ$8,450 Nelson

Business
Master of Applied Management 9 15 months Feb, May, Jul, 

Sep, Nov
6.5 NZ$28,450 Nelson

Postgraduate Diploma in Applied 
Management

8 9-10 months Feb, May, Jul, 
Sep, Nov

6.5 NZ$20,900 Nelson

Postgraduate Certificate in Applied 
Management

8 5-6 months Feb, May, Jul, 
Sep, Nov

6.5 NZ$10,450 Nelson

Postgraduate Diploma in Logistics and 
Supply Chain Management

8 9-10 months Feb, May, Jul, 
Sep, Nov

6.5 NZ$20,900 Nelson

Bachelor of Commerce (Major in 
Accounting, Management or Marketing)

7 3 years Feb, Jul, Nov 6.0 NZ$18,900 Nelson, 
Marlborough# 

Bachelor of Commerce (Double Majors) 7 3.5 years Feb, Jul, Nov 6.0 NZ$18,900 Nelson, 
Marlborough# 

Graduate Diplomas in Accounting, 
Management or Marketing

7 1 year+ Feb, Jul, Nov 6.0 NZ$18,900 Nelson, 
Marlborough# 

Graduate Diploma in Professional 
Accounting

7 1 year+ Feb, Jul, Nov 6.0 NZ$18,900 Nelson, 
Marlborough# 

New Zealand Diploma in Business 5 1 year Feb, Jul 6.0 NZ$18,900 Nelson, 
Marlborough#

Cookery
Culinary Arts (New Zealand Diploma in 
Cookery (Advanced)) (Level 5)

5 1 year Feb 5.5 NZ$19,900 direct entry Nelson

Culinary Arts (New Zealand Certificate 
in Cookery) (Level 4)

4 1 year Feb, Jul 5.5 NZ$19,900 Nelson

Creative Industries
Bachelor of Arts and Media (Visual Arts 
and Design)

7 3 years Feb, Jul 6.0 NZ$18,900 Nelson

New Zealand Diploma in Arts and Design 6 2 years Feb, Jul 6.0 NZ$18,900 Nelson
New Zealand Diploma in Arts and Design 5 1 year Feb, Jul 6.0 NZ$18,900 Nelson
Contemporary Music
New Zealand Diploma in Music 5 2 years Feb 5.5 NZ$18,900 Nelson
Interior Design
Diploma in Interior Design 5 1 year Feb 6.0 NZ$18,900 Nelson
Engineering
Aviation
New Zealand Certificate in Aeronautical 
Engineering

4 2 years Feb, Jul 6.0 NZ$19,900 Woodbourne

Civil
New Zealand Diploma in Engineering 
(Civil Engineering)

6 2 years Feb 6.0 NZ$18,900 Nelson

Marine
New Zealand Diploma in Nautical 
Science

6 36-43 
weeks

Feb 6.0 NZ$16,900 - $23,399 Nelson

New Zealand Diploma in Marine 
Engineering

6 30-36 
weeks

Feb, Aug 6.0 NZ$19,900 Nelson

New Zealand Certificate in Maritime 
Crewing (Level 4) STCW AB Deck

4 17 weeks Jan 4.0 NZ$8,782 Nelson

**Subject to NZQA and TEC approval. +Depending on start date, may include Summer School semester. If your undergraduate degree is not in a relevant field, you may need to completed additional courses, which may require 18 months total study.  
#Not all majors offered in Marlborough. ##See programme listing for details.



Programme Level Full time Start date IELTS Fees per year* (NZ$) Campus
Health, Social and Community Services
Certificate in Nursing (Competence 
Assessment Programme)(Level 7)

7 12 weeks Feb, May, Aug 7.0 NZD$9,750 Nelson

Bachelor of Nursing 7 3 years Feb 6.5 NZ$19,900 Nelson
New Zealand Certificate in Study and 
Career Preparation Health pathway

4 19 weeks Feb, Jul 5.5 NZ$8,450 Nelson, 
Marlborough

Computer Generated Imagery
Bachelor of Computer Generated 
Imagery

7 3 years Feb 6.0 NZ$18,900 Nelson

New Zealand Diploma in Animation 5 & 
6

2 years Feb 6.0 NZ$18,900 Nelson

Counselling and Social Work
Paetahi Tumu Kōrero Bachelor of 
Counselling

7 3 years Feb 6.5 NZ$18,900 Nelson

Bachelor of Social Work 7 4 years Feb 6.5 NZ$18,900 Nelson
New Zealand Certificate in Study and 
Career Preparation - Counselling and 
Social Work pathway

4 19 weeks Jul 5.5 NZ$8,450 Nelson

Career Coaching and Development
Bachelor of Career Development 7 3 years Feb 6.5 NZ$18,900 Nelson
Beauty Therapy
New Zealand Diploma in Beauty Therapy 5 2 years Feb 5.5 NZ$18,900 Nelson, 

Marlborough
Applied Fitness
New Zealand Diploma in Sport, 
Recreation and Exercise (Multi-Sector)

5 & 
6

2 years (1 
year per 
level)

Feb 6.0 NZ$16,900 Nelson

AUT Bachelor of Sport and Recreation 7 1 year## Feb 6.0 Refer to website Nelson
Information Technology
Postgraduate Diploma in IT Security 
Management

8 9-10 months Feb, Jul 6.5 NZ$20,900 Nelson

Graduate Diploma in Information 
Technology

7 1 year Feb, Jul, Nov 6.0 NZ$18,900 Nelson

Bachelor of Information Technology 
(Major in Information Systems, Systems 
Development or ICT Infrastructure)

7 3 years Feb, Jul 6.0 NZ$18,900 Nelson

New Zealand Diploma in Information 
Technology Technical Support or Web 
Development and Design

5 1 year Feb 6.0 NZ$18,900 Nelson

Primary Industries
Aquaculture
Postgraduate Diploma in Sustainable 
Aquaculture

8 1 year Feb 6.5 NZ$20,900 Nelson

Bachelor of Aquaculture and Marine 
Conservation

7 3 years Feb 6.0 NZ$18,900 Nelson

Viticulture
Bachelor of Viticulture and Winemaking 7 3 years Feb, Jul 6.0 NZ$18,900 Marlborough
Tourism
Tourism and Travel
New Zealand Certificate in Tourism 
(Operations)

4 19 weeks Jul 5.5 NZ$8,450 Nelson

Adventure Tourism
Diploma in Adventure Tourism 5 2 years Feb 5.5 NZ$18,900 Nelson
Superyacht
Certificate in Superyacht Crewing 3 12 weeks Feb, May, Aug 5.0 NZ$8,500 Nelson
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Student life
SANITI is your fun, friendly and independent student 
association; providing events and services to NMIT students. 
The team is located on the Nelson Campus and visits the 
Marlborough and Woodbourne Campuses regularly.

SANITI is run by students. Their services include 
events, support, advocacy, and assistance with 
employment and an effective voice for students. 

For further information about SANITI like them on 
Facebook at facebook.com/SANITINZ or visit their 
website at saniti.org.nz.



Make your decision and apply
You can apply online at nmit.ac.nz or download an application 
form online and send a scanned copy to us by email to 
international@nmit.ac.nz, or send it by post to Information and 
Enrolments Centre, NMIT, 322 Hardy Street, Private Bag 19, Nelson 
7042, New Zealand. 
Remember to include a certified copy of your passport, certified 
copies of your academic records, proof of English proficiency, 
details of any work experience and any additional information 
required for specific programme entry.
If you need assistance with your accommodation arrangements, 
www.nmit.ac.nz/study/applying/before-you-arrive/
accommodation-and-transfers/

Recognition of Academic Credit
If you already have a professional qualification and previous 
work experience or other tertiary qualifications and would 
like to be considered for credit exemptions to complete your 
study in a shorter time, please enquire about this service at 
international@nmit.ac.nz when you apply.

NMIT will inform you of our decision
If NMIT accepts your application, we will send you the following 
Acceptance Documents:

> Offer of Place
> Confirmation of Acceptance Form
> Notification of Fees
> International Student Fees, Charges and Refund Policy
> Information on compulsory travel and medical insurance.

Accept your offer
Formally accept our offer by returning a signed Confirmation of 
Acceptance Form and pay the fees outlined in the Notification 
of Student Fees. Payment may be made by bank draft, cheque, 
telegraphic transfer or credit card.

NMIT will confirm your enrolment
After we receive your payment we then send you receipt 
documents.
You will need to supply this document to Immigration New Zealand 
if you are applying for a visa.

Apply for a visa
You should now be ready to apply for your visa, using the forms 
available from your local New Zealand Embassy, High Commission, 
your agent or Immigration New Zealand (immigration.govt.nz). Be 
sure to allow enough time to complete this procedure.

Book your travel
Allow also enough time to organise your travel to 
New Zealand and please inform us about your travel 
arrangements. We look forward to welcoming you to NMIT. 
Have you remembered to tell us about your accommodation?

How to apply
1

2

3

4

5

6

Payment
We recommend that you apply 
and enrol early, as places can fill 
quickly in many programmes. Late 
applications may be considered if 
there are places available on the 
programme. 
We can help you at any stage of this 
process. 
If you have any questions, please 
contact us at any time by emailing 
international@nmit.ac.nz.

Payment can be made by:
Telegraphic Transfer
Payment can be made by bank 
draft or telegraphic transfer to the 
following account:
Bank of New Zealand
266 Trafalgar Street, Nelson 7010
Nelson Marlborough Institute of 
Technology, New Zealand
02 0704 0190770 003
Swift Code: BKNZNZ22
Attention: International Enrolments
Please also have your student ID 
number put as a reference so it is 
easier to trace.
Please note that bank charges may 
apply.
Cheque/Bank Draft
Payment must be in New Zealand 
dollars made out to:
Nelson Marlborough Institute of 
Technology
Post to:
Nelson Marlborough Institute of 
Technology
Private Bag 19, Nelson 7042, New 
Zealand
Attention: International Enrolments
Please also have your name input as a 
reference so it is easier to trace.
Please note that bank charges may 
apply.
Credit Card Payment
Another option is to pay by credit 
card (Visa, MasterCard or Bankcard).
To make a payment by credit card, 
please email international@nmit.ac.nz

Code of practice
Nelson Marlborough Institute of 
Technology has agreed to observe 
and be bound by the Code of 
Practice for the Pastoral Care of 
International Students published by 
the Ministry of Education. Copies of 
the Code are available on request 
from this institution or from the 
New Zealand Ministry of Education 
website at education.govt.nz.
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NMIT Nelson, 322 Hardy Street, Private Bag 19, Nelson 7042, Ph: 03 546 9175. 

NMIT Marlborough, 85 Budge Street, PO Box 643, Blenheim 7240, Ph: 03 578 0215. 

Fees disclaimer:* Fees listed are 2019 annual figures set in accordance with the TEC Fee 
regulations and indicative only, as fees may vary dependent on actual courses selected. 
Exact fees can be confirmed when you apply. Student Services Levy, text books, printing, 
stationery, additional registration fees, additional course costs and academic attire for 
graduation are all the responsibility of the student. Where additional costs apply, these 
may be made available on the website or alternatively on request. Every effort has been 
made to ensure that the fee information set out is correct at time of printing, however NMIT 
accepts no responsibility for any claim whatsoever arising from any error contained in this 
document. International learners are required to pay international fees and additional 
costs to attend one of our courses or programmes. These additional costs include medical 
and travel insurance cover. Please email international@nmit.ac.nz for further information.
Disclaimer: Please note, the information in this brochure is provided for your information 
and guidance. Every effort has been made to ensure it was accurate at the time of 
publication. Academic requirements and Entry requirements in this document are a 
summary and should be used as a guide only. All NMIT programmes have English Language 
entry requirements for applicants whose first language is not English. For the most up-to-
date information, or for full details on entry requirements, contact NMIT Information and 
Enrolment Centre on 0800 422 733 or visit nmit.ac.nz. All programmes are run subject to 
sufficient student numbers. Where duration is stated in weeks, these include holiday periods.
Last Published: July 2019


